
A GUIDE TO FORMATTING WRITTEN WORK AT SVDP 
St. Vincent de Paul Regional Seminary 

(Approved November 13, 2017) 

This document aims to offer you a brief guide for preparing written work here at SVDP according to the 
17th edition of the Chicago Manual of Style (CMS).1 These norms apply the manual’s broad standards to the 
needs of our academic programs. As students, you should follow these norms in formatting your papers, 
especially in citing sources. Faculty may specify deviations from this guide; if they do, follow their directions. 

1. Basic Formatting Matters 

1.1 The Structure of a Research Paper 

The eighth edition (2013) of Kate Turabian’s guide, A Manual for Writers of Research Papers, Theses, 
and Dissertations, applies the norms of CMS to students’ needs.2 These rules generally follow her advice: 

a. Title Page: Every paper should have a creative, descriptive title. On your title page, include your 
name, the course title, and the due date of the paper. See Appendix A for an example. 

b. Margins: Using letter-size (8.5-by-11-inch) paper, leave a one-inch margin on all four edges of the 
paper. Since an ordinary research paper is not bound, there is no need for a gutter. 

c. Spacing: Double-space the main text, but single-space block quotations and any lists or outlines you 
may include. In your bibliography, each source should be single-spaced internally but with at least a 
little space between each source (see Appendix B for an example). Also single-space footnotes. 
(Although Turabian recommends putting a blank space between each note, SVDP’s style omits this 
space as omitting that space is the default in Microsoft Word.) Type only one space, and not two, 
between sentences (CMS 2.9). 

d. Indentation: Indent the first line of each paragraph. Also indent all lines of a block quotation (using 
indent function under the Paragraph menu from the Home tab in Word, not the tab key).  

e. Page Numbers/Headers/Footers: Place a right-aligned page number in a header of every page of 
your paper except the title page, which has neither a page number nor any other header. You should 
not have a footer anywhere in your document. This document exemplifies these rules. 

1.2 Font Settings 

Use a professional-looking font (such as Times New Roman, Calibri, Arial Narrow, Palatino Linotype, 
etc.). Use 12-point font for the entire document, except for footnotes, which require 10-point font. You may 
use a larger font on your title page if you prefer. 

1.3 Headings 

In papers that exceed five pages in length (not counting the title page or bibliography), it is helpful to your 
reader if you break up your text with headings. Headings should be in 12-point bold font and, if you need a 
second level of headings, use 12-point bold italics. Note that this document observes this practice. 

                                                      
1 University of Chicago Press, The Chicago Manual of Style, 17th ed. (Chicago: University of Chicago Press, 2017). 
2 Kate L. Turabian, A Manual for Writers of Research Papers, Theses, and Dissertations: Chicago Style for Students & 

Researchers, ed. Wayne C. Booth, Gregory G. Colomb, Joseph M. Williams, and the University of Chicago Press Editorial Staff, 
8th ed. (Chicago: University of Chicago Press, 2013), 372–77. 
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1.4 Quotations 

When you quote from sources, you may either run in your quotation to the surrounding text or set it off as 
a block quotation. (See models of both in Example 1 below). In general, short quotations (less than a hundred 
words) should be run in and longer quotations should be set off as block quotations (CMS 13.9–10). Always 
be sparing and judicious in borrowing the words of other authors. Every quotation should have a reason for 
its inclusion. After all, you are the author of your paper; your voice should dominate.3 When quoting poetry 
(especially biblical texts such as psalms and canticles), it is best to set it off as a block quotation.  

EXAMPLE 1: Run-In and Block Quotations 

Text in the Original Source: 

To hold your listeners’ attention, you must seem to be not lecturing at them but rather amiably conversing 
with them, a skill that does not come easily, because few of us can write as we speak and because most of 
us need notes to keep us on track. If you must read, read no faster than about two minutes a page (at about 
three hundred words a page). The top of your head is probably not your most attractive feature, so build in 
moments when you deliberately look straight out at your audience, especially when you’re saying something 
important. Do that at least once or twice a page. 

Run-In Quotations in a Paragraph: 

Public speakers must balance maintaining a conversational tone with their audience with heeding the 

famous injunction to “omit needless words.”4 A popular manual advises such presenters: “The top of your 

head is probably not your most attractive feature, so build in moments when you deliberately look straight 

out at your audience, especially when you’re saying something important.”5 

Block Quotation: 

 Public speakers have a difficult job. To assist them in this challenging duty, Turabian offers the 

following sage advice: 

 To hold your listeners’ attention, you must seem to be not lecturing at them but rather amiably 
 conversing with  them. … If you must read, read no faster than about two minutes a page (at 
 about three hundred words a page). The top of your head is probably not your most attractive 
 feature, so build in moments when you deliberately look straight out at your audience, especially 
 when you’re saying something important. Do that [look at your listeners] at least once or twice a 
 page.6 

You must quote material exactly as written. Make only those changes explicitly allowed by CMS 13.7–8, 
such as changing an initial lowercase letter to uppercase (or vice versa) if required by the grammar of the 
surrounding context or adding a period if your quotation concludes a sentence. Note that periods and commas 

                                                      
3 For more guidance about how and when to quote, see http://www.uc.utoronto.ca/quotations. 
4 William Strunk Jr. and E. B. White, The Elements of Style, 4th ed. (New York: Longman, 2000), 23. 
5 Turabian, Manual for Writers, 126. Emphasis added. 
6 Ibid. 

http://www.uc.utoronto.ca/quotations
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always appear inside quotation marks, never outside them.7 If you must shorten a quotation, use ellipsis 
points (…) to indicate that you have omitted text in a quotation; it is not necessary to enclose ellipsis points 
in square brackets. If you need to clarify something in a quotation or supply missing information, enclose your 
added words in square brackets (see CMS 13.59–61). If you choose to add emphasis to quoted text, be sure 
to include “emphasis added” at the end of your footnote citation (CMS 13.62; see footnote 5 above). Example 
1 above models these rules. 

1.5 Biblical Languages 

In general, transliterate the text of biblical languages because most readers for whom you will write (except 
Scripture professors) lack knowledge of biblical Greek and Hebrew. If your instructor asks you to use Greek 
or Hebrew characters, use a Unicode font (obtained in Microsoft Word via the Symbol menu from the Insert 
tab) or send your document as a PDF; otherwise, the characters may not display properly. 

1.6 Inclusive (Bias-Free) Language 

Out of reverence for the dignity of all human persons and in recognition of the ongoing evolution of the 
English language, SVDP policy requires the use of gender-inclusive language in all written work. A general 
exception to this rule applies to quotations, which must reproduce the original text exactly (CMS 13.6). 
Effective writing seeks to maintain credibility with its readers and thus avoids language that may offend or 
distract them (CMS 5.251). For suggestions on how to write with bias-free language, see CMS 5.251–60. 
Note, however, that the latest edition of CMS continues to discourage the use of they, them, their, and 
themselves (or the ghastly themself) as singular pronouns (CMS 5.48; 5.256). 

2. Citations and Bibliographies 

As an author, you have an obligation in justice to acknowledge the labor of those from whose work you’ve 
borrowed. Careful citations and thorough bibliographies are hallmarks of serious research. Sloppy citations 
and superficial bibliographies, on the other hand, undermine the author’s credibility. In written work at SVDP, 
always use the notes-and-bibliography style for citing sources. This guide summarizes this style; more 
comprehensive instructions and abundant examples can be found in chapter 14 of CMS.  

2.1 General Rules for Footnotes 

Here at SVDP, we follow the default in Microsoft Word for footnotes. Therefore, set footnotes in 10-point 
font and single-space them internally, as Word does automatically. If, however, you have several long notes 
or have an advanced command of the Styles feature in Word, you may wish to indent all your footnotes (as 
this document does) as doing so makes them more readable. To insert a footnote in Microsoft Word, click 
Insert Footnote under the References tab. The note reference numbers in the text are superscript numbers. 
Following the Word default, we leave the note reference numbers in superscript for the footnotes as well. 

Unless faculty give you instructions otherwise, we observe the traditional practice of giving a full citation 
for each source in the first footnote in which you cite the source. All subsequent citations of that same source 
use the shortened citations format described below. (See Example 2 below for examples of full and shortened 
citations that would be common in a theology paper.) Some professors, however, may ask you to use the 
shortened citations exclusively, even for the first footnote in which you cite a source, because full citation 
information appears in the bibliography (CMS 14.19). Shortened citations are discussed in CMS 14.29–34. 
To compose a shortened citation, include only the author’s last name, a short form of the title (no more than 

                                                      
7 The sole exception to this rule occurs in software contexts, with typing instructions and computer-file names (see CMS 7.79). 
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four words), and the page number (or, in the case of an unpaginated source, as clear a locator as possible). 
You may also use “ibid.” (not put in italics) for consecutive footnotes that cite the same single source (CMS 
14.29–30), although Chicago now discourages this practice (CMS 14.34). The abbreviations “op. cit.” and 
“loc. cit.” are no longer permitted by Chicago; shortened citations take their place (CMS 14.36). Notice that 
the footnotes and examples in this document demonstrate how to follow these rules. Many more examples 
can be found at http://www.chicagomanualofstyle.org/tools_citationguide/citation-guide-1.html. 

EXAMPLE 2: Footnotes in First and Subsequent Citations 

First Citations of Sources: 
1 Daniel Harrington, Interpreting the New Testament (Collegeville, MN: Liturgical, 1990), 56. 
2 David Toshio Tsumura, “Tense and Aspect of Hebrew Verbs in 2 Samuel 7:8–16—from the Point of View of Discourse 

Grammar,” Vetus Testamentum 60, no. 4 (2010): 643, accessed October 1, 2017, https://doi.org/10.1163/156853310X536770. 
3 2 Sm 7:4, 17. Unless otherwise indicated, all biblical quotations are from the New American Bible: Revised Edition (NABRE). 
4 Stephen Pisano, “The Prophecy against the House of Eli (1 Sam 2,27–36),” in Biblical Exegesis in Progress: Old and New 

Testament Essays, ed. Jean-Noël Aletti and Jean-Louis Ska, Analecta biblica 176 (Rome: Editrice Pontificio Istituto Biblico, 2009), 
97–103. 

5 Susan Rattray, “Bronze Age,” in The HarperCollins Bible Dictionary, ed. Mark Allan Powell (New York: HarperOne, 2011), 
108. 

6 Frank S. Frick and Mark Allan Powell, “King,” in Powell, HarperCollins Bible Dictionary, 514–15. 
7 John Paul II, Apostolic Exhortation Pastores Dabo Vobis (1992), no. 24, accessed September 18, 2017, 

http://w2.vatican.va/content/john-paul-ii/en/apost_exhortations/documents/hf_jp-ii_exh_25031992_pastores-dabo-vobis.html. 

Subsequent Shortened Citations of the Same Sources: 
8 Harrington, Interpreting the New Testament, 67. 
9 Tsumura, “Tense and Aspect,” 643. 
10 2 Sm 7:11b–16. 
11 Pisano, “Prophecy,” 118. 
12 Rattray, “Bronze Age,” 108. 
13 Frick and Powell, “King,” 514. 
14 John Paul II, “On Parishes,” 124–26. 

When the same source is cited frequently, such as with a work on which you are providing a detailed 
commentary, professors may allow you to cite it in parentheses rather than in footnotes. (CMS 13.64–67, 
14.58–59). For example, exegetical papers often use parentheses for references to the biblical text under 
examination (but footnotes for all other sources), as seen in Example 4 below. Note, however, that footnotes 
are the rule and parenthetical references the exception, so always check with your instructor before using of 
parenthetical citations. Feel free also to insert brief commentary in footnotes, but be careful not to burden 
your reader with excessively verbose notes (see 14.56–60 for more information). 

2.2 General Rules for Bibliographies 

Your bibliography should begin a new page at the end of your paper, after any appendices or tables that 
may be needed. Unless a compelling reason suggests that a bibliography be divided into sections (see CMS 
14.63), present your bibliography as a single alphabetized list of sources. In general, bibliographies are 
alphabetized by the author’s last name. For more information on how to alphabetize in more complex cases, 
see CMS 16.56–61. See Appendix B for a properly formatted bibliography.  

3. Specific Issues Common in Seminary Writing 

Guidance for citing most sources appears in CMS 14.100–305 and on the CMS website (see the hyperlink 
in Section 2.1 above). This document only treats cases that merit greater treatment than that given in CMS. 

http://www.chicagomanualofstyle.org/tools_citationguide/citation-guide-1.html
https://doi.org/10.1163/156853310X536770
http://w2.vatican.va/content/john-paul-ii/en/apost_exhortations/documents/hf_jp-ii_exh_25031992_pastores-dabo-vobis.html
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3.1 Authors’ Names 

a. Degrees and affiliations (such as initials for religious orders) are never included in citations (CMS 
14.73). The titles of saints, popes, monarchs, and the like are also omitted in citations (CMS 14.83). 

b. For sources with multiple authors, all names are included in the bibliography (up to ten). In footnotes, 
however, a source with four or more authors is listed with only the first author’s name followed by the 
abbreviation “et al.” (“and others”); note that et does not take a period, but al. does (CMS 14.76). 

3.2 Citing Multiple Contributions from the Same Edited Work 

If you are using only one contribution (or chapter) from an edited work, use a full chapter citation as in the 
Pisano bibliography entry of Appendix B below (and, for footnotes, notes 4 and 10 of Example 2 above). If 
you cite several contributions (or chapters) from the same edited work, cite the full book itself as a separate 
item in the bibliography and then provide a shortened chapter citation for each contribution. For examples of 
bibliography entries of such a work, see Appendix B’s treatment of the works of Freedman, Powell, and 
Senior (overall works), and the chapters from those volumes by Grayson, Bandstra, and Hoppe. In footnotes, 
cite the contribution (or chapter) and include a full citation of the multiauthor work the first time, and then cite 
the chapter and use a shortened citation for the edited work portion thereafter even if you’re citing a different 
contribution from that same multiauthor work. See the entries for the contribution by Rattray as well as that 
by Frick and Powell from the work edited by Powell in Example 2 above. See CMS 14.107–112 for more. 

3.3 Citing Electronic Sources 

The technological revolution has been a blessing to research, but the proper citation of electronic sources 
requires a few additional steps. Heed your instructor’s guidance on discerning the reliability of online sources, 
as the various academic disciplines have different standards on these matters.8 The most important rule 
when citing online sources is to ensure that your reader can easily locate the material for further consultation. 
To that end, always provide a DOI (Digital Object Identifier) if one is available, or, if one is lacking, a URL 
(Uniform Resource Locator) in your full footnote citations and bibliographies (CMS 14.8). The latest edition 
of CMS requires that you append the DOI after “https://doi.org/” in order to construct a complete URL, as in 
Example 3 below. Do not include a DOI or URL in shortened citations, however. Unless your instructor directs 
otherwise, provide the access date on which you consulted the online content (CMS 14.12). 

EXAMPLE 3: Including a DOI in Footnotes (See Appendix B for Examples in a Bibliography) 

DOIs for Sources: 

For first footnote below, the DOI is 10.1163/156853311X585568. 
For second footnote below, the DOI is 10.1163/156853310X536770. 

First Footnote of Sources: 
1 Thilo Alexander Rudnig. “König ohne Tempel: 2 Samuel 7 in Tradition und Redaktion,” Vetus Testamentum 61, no. 3 (2011): 

426–46, accessed August 24, 2017, https://doi.org/10.1163/156853311X585568. 
2 David Toshio Tsumura, “Tense and Aspect of Hebrew Verbs in 2 Samuel 7:8–16—from the Point of View of Discourse 

Grammar,” Vetus Testamentum 60, no. 4 (2010): 643, accessed October 1, 2017, https://doi.org/10.1163/156853310X536770. 

With electronic books and software programs, be sure to indicate the medium in which you accessed 
these sources, following the guidance of CMS 14.159–62. Give as precise a locator in place of a page number 
if the electronic edition is unpaginated (e.g. use a chapter or section number). For examples, see the entries 
for Koehler and Sicré Diaz in Appendix B. 

                                                      
8 For help in determining the reliability of online resources, see https://www.csuchico.edu/lins/handouts/eval_websites.pdf. 

https://doi.org/
https://doi.org/10.1163/156853311X585568
https://doi.org/10.1163/156853310X536770
https://mail1.svdp.edu/owa/redir.aspx?C=nmkgeqa4UgaUU9T-P5lforIKdZmnNyk8qd2M9nQfQmGdIHN9VgDVCA..&URL=https%3a%2f%2fwww.csuchico.edu%2flins%2fhandouts%2feval_websites.pdf
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3.4 Citing Biblical Text and Translations 

In the main text of your paper, spell out the names of biblical books but use numerals for books that have 
numbers in their names; use abbreviations in parentheses, notes, and lists (CMS 10.44). Use a nonbreaking 
space (obtained in Microsoft Word by pressing Ctrl + Shift + Spacebar) between the number and the main 
book name; this special kind of space always keeps the items it separates on the same line, thus ensuring 
that the entire book name appears together. The books of the Bible and the noun “Bible” are always 
capitalized but never italicized (CMS 8.103–6). Use a colon between the chapter and verse, and use commas 
to separate verses of the same chapter from each other (see CMS 14.239). If you refer only to part of a verse, 
use a letter suffix after the verse number (“a” means the first half of the next verse; “b” means the second 
half; “ab” means the first two-thirds, etc.). Example 4 illustrates these rules: 

EXAMPLE 4: Biblical Citations 

The final demonstration of the letter comprises Galatians 5:13–6:10. (For Paul’s treatment of love in this 
context, see Gal 5:6, 14, 22. For texts with similar themes, see Lv 19:18, Rm 14:10b, and 1 Cor 13:1–7.) 

Use the abbreviations for biblical books in the table below (see CMS 10.44–48). They are listed from left 
to right in the canonical order observed in The Catholic Study Bible (see entry for Senior in Appendix B). 
When an abbreviation includes a number, use a nonbreaking space between the number and abbreviation. 
Note that none of these abbreviations take periods. (“Ps” is for a single psalm; “Pss” is for multiple psalms.) 

Gn Ex Lv Nm Dt Jo Jgs Ru 1 Sm 2 Sm 

1 Kgs 2 Kgs 1 Chr 2 Chr Ezr Neh Tb Jdt Est 1 Mc 

2 Mc Jb Ps (Pss) Prv Eccl Sg Wis Sir Is Jer 

Lam Bar Ez Dn Hos Jl Am Ob Jon Mi 

Na Hb Zep Hg Zec Mal Mt Mk Lk Jn 

Acts Rom 1 Cor 2 Cor Gal Eph Phil Col 1 Thes 2 Thes 

1 Tm 2 Tm Tit Phlm Heb Jas 1 Pt 2 Pt 1 Jn 2 Jn 

3 Jn Jude Rv 

Do not include biblical editions and versions in your bibliography (CMS 14.239–40). Instead, after your 
first biblical citation, give a footnote such as, “Unless otherwise indicated, all English biblical citations are 
from the New Revised Standard Version (NRSV).” See the third and ninth notes in Example 2 above. 

3.5 Citing Classical, Patristic, and Medieval Sources 

The norms governing classical Greek and Latin references, which are summarized here, suffice for citing 
most patristic and medieval sources (see CMS 14.242–52). Ordinarily, these sources need not appear in 
bibliographies unless you refer to a modern author’s annotations (CMS 14.242) or choose to cite them by a 
modern edition’s page numbers (as in CMS 14.251). For mere references and quotations to the text itself, a 
simple footnote suffices. If you are referring to a specific translation, you may indicate it in a footnote (CMS 
14.246), as in the second example below. Although CMS prefers to use only Arabic numerals instead of 
Roman numerals (CMS 14.243), cite the Summa Theologiae of St. Thomas by part (with Roman numerals), 
question, and article. 

EXAMPLE 5: Footnotes for Classical, Patristic, and Medieval Sources 

1 Plato, Republic 360e–361b. 
2 Augustine, Confessions, trans. Maria Boulding (New York: Vintage, 1999), 10.14.21. 
3 Thomas Aquinas, Summa Theologiae I, q. 1, a. 10. 
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3.6 Citing Church Documents (i.e. Ecumenical Councils, Papal Documents, Curial Documents, etc.) 

Ecclesiastical documents are difficult to cite, given the various types of documents and different authority 
they carry. For full citations in notes and bibliographies, give the author, type of document without italics (if 
applicable) followed by the Latin incipit or title in either italics or quotation marks (treat longer documents like 
books, with italics for the title, and treat shorter documents like articles, with quotation marks for the title), the 
date of publication, and facts of publication. Prominently including the type of document clarifies its authority 
for your reader. If the document contains numbered sections or paragraphs, use these reference numbers 
instead of page numbers, preceded by the abbreviation “no.” or “nos.” For simplicity, put Latin titles in 
headline style like English titles (capitalizing all main words) and unlike the usual practice for foreign-language 
titles (see CMS 11.6). A parenthetical annotation may also be included after the title if it seems helpful. 
Shortened citations of these documents need only include the author, title, and page/section number. 

Example 6 shows how to cite church documents using this system. Note a few features: (1) The line used 
to indicate a repeated author is created by typing three consecutive em dashes (———); the em dash (—) 
can be found in the Symbol menu from the Insert tab, under “General Punctuation.” (2) Abbreviations can be 
helpful in some situations; see the second and fifth examples in all three groups below. (3) These citations 
often require some flexibility; your goal is to direct your reader to your source with minimal effort (hence the 
use of both section and page numbers in the fifth example below). 

EXAMPLE 6: Citations of Church Documents 

Full Citations in Footnotes: 
1 Benedict XVI, Encyclical Deus Caritas Est (Boston: Pauline, 2005), no. 39. 
2 Congregation for Divine Worship and Discipline of the Sacraments (CDW), Instruction Redemptionis Sacramentum (Boston: 

Pauline, 2004), nos. 98–99. 
3 John Paul II, Apostolic Exhortation Pastores Dabo Vobis (1992), no. 24, accessed September 18, 2017, 

http://w2.vatican.va/content/john-paul-ii/en/apost_exhortations/documents/hf_jp-ii_exh_25031992_pastores-dabo-vobis.html. 
4 John Paul II, “On Parishes, Lay Ministry and Women” (ad limina address to bishops from the provinces of Baltimore, 

Washington, Atlanta, and Miami), Origins 23 (July 15, 1993): 124–26. 
5 Vatican Council II, Pastoral Constitution Gaudium et Spes (1965), in The Sixteen Documents of Vatican II, ed. Marianne 

Lorraine Trouvé (Boston: Pauline, 1999), no. 16 (= pp. 638–39). (Subsequent citations of this document will use the abbreviation 
GS followed by a section number.) 

Shortened Citations: 
6 Benedict XVI, Deus Caritas Est, no. 39. 
7 CDW, Redemptionis Sacramentum, nos. 98–99. 
8 John Paul II, Pastores Dabo Vobis, no. 24. 
9 John Paul II, “On Parishes,” 124–26. 
10 GS 16. 

Bibliography Entries: 

Benedict XVI. Encyclical Deus Caritas Est. Boston: Pauline, 2005. 

Congregation for Divine Worship and Discipline of the Sacraments. Instruction Redemptionis Sacramentum, 
Boston: Pauline, 2004. 

John Paul II. Apostolic Exhortation Pastores Dabo Vobis. 1992. Accessed September 18, 2017. 
http://w2.vatican.va/content/john-paul-ii/en/apost_exhortations/documents/hf_jp-
ii_exh_25031992_pastores-dabo-vobis.html. 

———. “On Parishes, Lay Ministry and Women” (ad limina address to bishops from the provinces of 
Baltimore, Washington, Atlanta, and Miami). Origins 23 (July 15, 1993): 124–26. 

Vatican Council II. Pastoral Constitution Gaudium et Spes. 1965. In The Sixteen Documents of Vatican II, 
edited by Marianne Lorraine Trouvé, 627–719. Boston: Pauline, 1999. 

http://w2.vatican.va/content/john-paul-ii/en/apost_exhortations/documents/hf_jp-ii_exh_25031992_pastores-dabo-vobis.html
http://w2.vatican.va/content/john-paul-ii/en/apost_exhortations/documents/hf_jp-ii_exh_25031992_pastores-dabo-vobis.html
http://w2.vatican.va/content/john-paul-ii/en/apost_exhortations/documents/hf_jp-ii_exh_25031992_pastores-dabo-vobis.html
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Birch, Bruce C. “The First and Second Books of Samuel.” In New Interpreter’s Bible, vol. 2, 949–1383. 

Bright, John. A History of Israel. 4th ed. Edited by William P. Brown. Louisville: Westminster John Knox, 2000. 
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Frick, Frank S., and Mark Allan Powell. “King.” In Powell, HarperCollins Bible Dictionary, 514–15. 

Grayson, A. Kirk. “Mesopotamia, History of: History and Culture of Assyria.” In Freedman, Anchor Bible 
Dictionary, vol. 4, 732–55. 

———. “Mesopotamia, History of: History and Culture of Babylonia.” In Freedman, Anchor Bible Dictionary, 
vol. 4, 755–77. 

Greeven, Heinrich, and Johannes Fichtner. “πλησίον.” In Theological Dictionary of the New Testament, 
edited by Gerhard Friedrich, translated by Geoffrey W. Bromiley, vol. 6, 311–18. Grand Rapids: 
Eerdmans, 1968. 

Harrelson, Walter J., ed. The New Interpreter’s Study Bible. Nashville: Abingdon, 2003. 

Harrington, Daniel. Interpreting the New Testament. Collegeville, MN: Liturgical, 1990. 

Hoppe, Leslie J. “The Deuteronomistic History.” In Senior, Collins, and Getty, Catholic Study Bible, RG 179–
228. 

Irwin, Brian P. “Not Just Any King: Abimelech, the Northern Monarchy, and the Final Form of Judges.” Journal 
of Biblical Literature 131, no. 3 (2012): 443–54. 

Joüon, Paul, and T. Muraoka. A Grammar of Biblical Hebrew. 2nd ed. Subsidia biblica 27. Rome: Gregorian 
& Biblical, 2006. 

Knapp, A. Bernard. “Mesopotamia, History of: Mesopotamian Chronology.” In Freedman, The Anchor Bible 
Dictionary, vol. 4, 714–20. 

Koehler, Ludwig, and Walter Baumgartner. The Hebrew and Aramaic Lexicon of the Old Testament. 
Translated and edited under the supervision of M.E.J. Richardson. 5 vols. Leiden: Brill, 1994–2000. 
Electronic edition in BibleWorks 10. 

Mann, Thomas W. The Book of the Former Prophets. Eugene, OR: Cascade, 2001. 

Mattingly, Gerald L. “Philistines.” In Powell, HarperCollins Bible Dictionary, 797–800. 
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